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Chapter 1
IEC60730B Safety library example user's guide

For easier development of the IEC60730B application, the library also provides the example code. This example is distributed
through the MCUXpresso SDK website. This example user's guide describes how to set the hardware correctly and how to use
the example code with the IEC60730B Safety library.

The library user's guide is the main documentation for IEC60730B. It is also part this package and accessible at
www.nxp.com/IEC60730.
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Chapter 2
Hardware settings

This chapter describes how to set up the hardware of the evaulation board. The MCU peripherals' setup is described later on.
The IEC60730B library example for the 1.MXrt family supports the following development boards:

+ EVKmimxrt1010

* EVKmimxrt1020

+ EVKmimxrt1024

* EVKmimxrt1050

+ EVKmimxrt1060

To run the IEC60730B example application, itis neccessary to make some hardware settings. For the default configuration of your
development board, see the corresponding board's user manual at www.nxp.com.

2.1 EVK-MIMXRT1010

To use the on-board debugger and power the board via USB, make sure that jumper J1 has the 1-2 pins shorted. Connect the
USB to connector J41.

The SW8 switch is used to select the boot mode. Set SW8 to boot from the QSPI flash (1-OFF, 2-OFF, 3-ON, 4-OFF).
See the MIMXRT 1010 EVK Board Hardware User’s Guide (document MIMXRT 1010EVKHUG) for more power and boot options.

The ADC module on EVK-MIMXRT1010 does not allow the VrefL and Bandgap to connect internally to the ADC input. Connect
these signals (for Analog I/O test) as follows:

* VrefH - 3.3 V connected internally.
» VrefL - connect GND to GPIO_AD_10 (J26-6).

» Bandgap - connect a custom reference (for example 1.65 V) to GPIO_AD_07 (J26-2). The expected value of the custom
bandgap can be set in the safefy _config.hfile (#define ADC BANDGAP LEVEL 1.65).
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Hardware settings

Figure 1. Hardware connection of EVK-MIMXRT1010

The tested voltage of 1.65 V is provided by the resistor voltage divider from VCC (3.3 V).

2.2 EVK-MIMXRT1020

To use the on-board debugger and power the board via USB, make sure that jumper J1 has pins 5-6 shorted. Connect the USB
to connector J23.

The SW8 switch is used to select the boot mode. Set SW8 to boot from the QSPI flash (1-OFF, 2-OFF, 3-ON, 4-OFF).
See the MIMXRT 1020 EVK Board Hardware User’s Guide (document MIMXRT1020EVKHUG) for more power and boot options.

The ADC module on EVK-MIMXRT1020 does not allow the VrefL and Bandgap to connect internally to the ADC input. Connect
these signals (for the Analog /O test) as follows:

» VrefH - 3.3 V is connected internally.
* VrefL - connect GND to GPIO_AD_B1_10 (J18-1).

» Bandgap - connect a custom reference (for example 1.65 V) to GPIO_AD_B1_11 (J18-2). The expected value of the custom
bandgap can be set in the safefy_config.hfile (#define ADC BANDGAP LEVEL 1.65).
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Hardware settings

Figure 2. Hardware connection of EVK-MIMXRT1020

The tested voltage of 1.65 V is provided by the resistor voltage divider from VCC (3.3 V).

2.3 EVK-MIMXRT1024

To use the on-board debugger and power the board via USB, make sure that jumper J1 has pins 5-6 shorted. Connect the USB
to connector J23.

The SW8 switch is used to select the boot mode. Set the SW8 to boot from the QSPI flash (1-OFF, 2-OFF, 3-ON, 4-OFF).
See the MIMXRT 1024 EVK Board Hardware User’s Guide (document MIMXRT1020EVKHUG) for more power and boot options.

The ADC module on EVK-MIMXRT1020 does not allow the VrefL and Bandgap to connect internally to the ADC input. Connect
these signals (for the Analog /O test) as follows:

» VrefH - 3.3 V is connected internally.
» VrefL - connect GND to GPIO_AD_B1_11 (J18-4).

» Bandgap - connect a custom reference (for example 1.65 V) to GPIO_AD_B1_10 (J18-2). The expected value of the custom
bandgap can be set in the safefy_config.hfile (#define ADC BANDGAP LEVEL 1.65).

i.MXRT10XX Safety Example, Rev. 0, 12/2020
User's Guide 6/23



https://www.nxp.com/doc/MIMXRT1020EVKHUG

NXP Semiconductors

Hardware settings

Figure 3. Hardware connection of EVK-MIMXRT1024

The test voltage of 1.65 V is provided by the resistor voltage divider from the VCC (3.3 V).

2.4 EVKB-IMXRT1050

To use the on-board debugger and power the board via USB, make sure that jumper J1 has pins 5-6 shorted. Connect the USB
to connector J41.

The SW7 switch is used to select the boot mode. Set the SW7 to boot from the QSPI flash (1-OFF, 2-ON, 3-ON, 4-OFF).
See the IMXRT 1050 EVKB Board Hardware User’s Guide (document IMXRT1050EVKBHUG) for more power and boot options.

The ADC module on EVKB-IMXRT1050 does not allow to connect VrefL and Bandgap internally to the ADC input. Connect these
signals (for the Analog /O test) as follows:

* VrefH - 3.3 V is connected internally.
» VrefL - connect GND to GPIO_AD_B1_10 (J23-1).

» Bandgap - connect a custom reference (for example 1.65 V) to GPIO_AD_B1_11 (J23-2). The expected value of the custom
bandgap can be set in the safefy _config.hfile (#define ADC BANDGAP LEVEL 1.65).
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Figure 4. Hardware connection of EVKB-IMXRT 1050

The test voltage of 1.65 V is provided by a resistor voltage divider from the VCC (3.3 V).

2.5 EVK-MIMXRT1060

To use the on-board debugger and power the board via USB, make sure that jumper J1 has pins 5-6 shorted. Connect the USB

to connector J41.

The SW7 switch is used to select the boot mode. Set the SW7 switch to boot from the QSPI flash (1-OFF, 2-OFF, 3-ON, 4-OFF).

See the MIMXRT1060 Evaluation Kit Board Hardware User's Guide (document UM11151UG) for more power and boot options.

The ADC module on EVK-MIMXRT1060 does not allow to connect VrefL and Bandgap internally to the ADC input. Connect these

signals (for the Analog /O test) as follows:
» VrefH - 3.3 V is connected internally.

» VrefL - connect GND to GPIO_AD_B1_10 (J23-1).

» Bandgap - connect a custom reference (for example 1.65 V) to GPIO_AD_B1_11 (J23-2). The expected value of the custom

bandgap can be set in the safefy _config.hfile (#define ADC BANDGAP LEVEL 1.65).
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Hardware settings

Figure 5. Hardware connection of EVK-MIMXRT1060
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The test voltage of 1.65 V is provided by a resistor voltage divider from the VCC (3.3 V).
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Chapter 3
File structure

Safety is only a small part of the whole SDK package for your device. The IEC60730 library and examples are located in the

middleware and in the board folders. The IEC60730 library is independent of the SDK and can be used stand-alone.

3.1 Library source files location

The library source files are in the middleware/safety iec60730b/safety/v4_1 folder in the SDK package.

The folder has the following structure:

Mame

&[]

[commaon_test]
[compiler]

[core_te

st]

|| IECB0730B_M4_MT7_KEIL v4_1

|| IECB0730B_M4_M7_COM_KEIL_v4_1
|| IECB0730B_M33_KEIL_v4_1

|| IECB0730B_M33_COM_KEIL_v4_1
|| IECB0730B_MO_KEIL_v4_1

|| IECB0T30B_MO_COM_KEIL_v4_1

B iect0720b_types

B iect0720b

| | bIECED
|| libIECED
| | libIECED
|| libIECED
|| libIECED
|| libIECED

730B_Md4_M7_MCUX_v4 1
730B_Md4_M7_COM_MCUX_v4_1
730B_M33_MCUX_v4_1
730B_M33_COM_MCUX_v4_1
730B_MO_MCUX_v4_1
730B_MO_COM_MCUX_v4_1

| IECE0730B_M4_M7_IAR_v4_1

| IECE0730B_M4_M7_COM_IAR_v4_1
| IECE0730B_M33_IAR_v4_1

| ] IEC60730B_M33_COM_IAR_v4_1

| ] IECA0730B_MO_IAR_v4 1

| ] IECA0730B_MO_COM_IAR_v4_1

Where:

+Ext

lib
lib
lib
lib
lib
lib

=TI - TR - T - TR - TR - T - TR - T - TR ~ I TR =T R Sl

F T S S S

» common_test contains the source files for the “peripheral” test — this is a common cross core. These tests are compiled to
library liblIEC60730B_<core>_COM_<compiler>_<version>.a.

» compiler - compiler support files.

» core_test contains the source files for the core-dependent test. These tests are compiled to library

lIbIEC60730B_<core>_<compiler>_<version>.a.

* jec60730b.his the main library header file.

* jec60730b_types.his the header file wi

ith the necessary defines for the library.

The folder also contains binary */ib files which are compiled for the IAR, Keil, and MCUXpresso IDEs (see the release notes

for details).

i.MXRT10XX Safety Example, Rev. 0, 12/2020

User's Guide

10/23



NXP Semiconductors

3.2 Example of library handling code

File structure

The library-handling code and the example aplication are separate from the library file. The example source files and other SDK

examples are at this path:
boards/<your board>/demo_apps/safety _iec60730b/

The safety example code is shown in Figure 6.

+Mame
&I
[iar]
| [mowu]
[mdk]
B cafety_test_items
5 safety_test_items
<o safety_iecB0730b
5 safety_config
B cafety_cmi_lpc
B cafety_cm0_lpc
=] readme
B oroject_setup_lpoxpressof45max
B oroject_setup_lpoxpressof45max
B pin_mux
5 pin_rnux
5 rmain
5 isr
B freemaster_cfg
B clock_config
B clock_config
B board
B board

Figure 6. Example of project structure in example folder

=
2

[ T o T i s o T o T o :'.'Hn:'r:'r

This folder contains the example source file and three folders for the IDE project file:

e jar
* mcecux

s mdk

The following files are generated by the MCUXpresso configuration tool:

* clock_config.h
 clock_config.c
e pin_mux.c

e pin_mux.h

Other files are used only for safety examples and their contents are described in the next chapter.
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Chapter 4
Example application

The structure of the example is common in all supported IDEs (IAR, Keil, MCUXpresso).

) safety iecb0TI0b - IAR Embedded Workbench IDE - Arm 8.40.1
File Edit View Praject J-link Tools Window Help

DlonEa@ = A& DC LS Q> B rE L
debug w
Files O .
E @ salety_iecB0730b - debug ™ o

M board
El board.c e
}— B boardh
& B clock_config.c .
— B clock_config h
& B pin_muxc a
L— & pin_munch
2 B CMSIS
= B component -
-8 i_--
- [ startc *
& [ starup_jarc ™
& [ veciors_ianc ™
L Blwectars_iarh
2 W device
— [ fzl_denice_registersh
— B LPCE45h
t— [ LPCB45_featuras.h
& [ system_LFCE45 ™
— B system_LPCE45h
= B coc
—E B drivers .
& 8 FreeMASTER ®
3 B |EC60730_Class_B L]
&1 & source
— [ freemaster_cfgh
— Bliseh
&[] miain.c ™
8 [ project_setup_lpcxpressoBdSmaxc s
— Bl project_setup_lpopressoB4Smaxh
& [ satety_cml_lpcc ®
— [ safety_cmi_lpch
— [ safety_config h
= [ safety_test_ilems.c ™
—— ] safety_test_femsh
=& M utilties .
= & Qutput

Figure 7. 1AR example application structure

The project contains the CMSIS, SDK, library, and safety example-related folders.

The safety-related folders are the following:
» Board - this folder contains the files related to the board used (clock _config.h, pin_config.h, board.h, and so on).
» CPU- this folder contains the startup code and vectors table.

* |[EC60730 Class_B - files for the IEC60730B Safety library.
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Example application

» Source - source file for the safety example (see the next explanation).

The example of project hiearchy is shown in Figure 8.

isr.h
freemaster_cfg.h

safety configh ——® main.c

l l |

project_setup.c safety_cm0.c safety_test_items.c
project_setup.h safety_cm0_h safety_test_items.h

|

IECE0730 Class B library

Figure 8. Example of project hiearchy

Figure 8 shows that the functions in the project_setup.cfile are called from the main.cfile. The library-handling functions are
located in the safety_cm4_cm7_imx8m.c/safety_cm4_cm7_imxrt.cfile and also called from the main.cfile.

The main example application header file safefy_config.h contains all definitions for running the safety test in examples. The
safety_test_items.cfile declares the structures for the DIO (or TSI) safety test. The project_setup_<your_board>.cfile contains the
setup functions (clock, port, UART, and so on). The safety_cm4_cm7_imx8m.c/safety_cm4_cm7_imxrt.c file contains the handling
function for safety routines from the IEC60730B library and also the test-initialization function for safety.

4.1 How to open the project

IAR IDE
Open the project file located at boards/<your_board>/demo_apps/safety_iec60730b/iar/safety_iec60730b.eww.

Arm Keil IDE
Open the project file located at boards/<your_board>/demo_apps/safety_iec60730b/mdk/safety_iec60730b.uvprojx.

MCUXpresso IDE

Firstly, drag and drop the <name_of the package>.zip package into the MCUXpresso IDE (into the "Installed SDKs" tab).
Secondly, import the SDK example (safety_iec60730b).
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Example application

If you are not familiar with the MCUXpresso IDE yet, see docs/Getting Started with MCUXpresso SDK for <your_board>.pdf("Build
an example application" section).

4.2 Example settings - safety_config.h

The main example settings header file is safefy_config.h. The neccessary macros for the safety example are defined in this file.

The "switch macros", which enable the user to turn off calling of the safety test, are defined in the beginning. When starting, turn
off the FLASH test and the WDOG test. On LPC devices, turn off also the Clock test.

/* This macro enables infinity while loop in SafetyErrorHandling() function */

#define SAFETY_ERROR_ACTION 1

/* TEST SWITCHES - for debugging it is better fo turn the flash test and watchdog OFF */
#define ADC_TEST_ENABLED 1

#define CLOCK_TEST_ENABLED 1

#define DIO_TEST_ENABLED 1

#define FLASH_TEST_ENABLED 1

#define PC_TEST_ENABLED 1

#define WATCHDOG_ENABLED 1

#define FMSTR_SERIAL_ENABLE 1

Other defines are used to configure the safety test as a parameter to a function or to fill structures.

4.3 safety_test_items.c file
The safety _test ifems.c and .hfiles are the configuration files for the DIO test.

The file contains the fs_dlio_test_<platform>_tlist of structures. The pointers to these structures are collected in the
dio_safety test items/] array, which is used in the example application.

#define MUX_ADDR(arg1) MUX_ADDR_(arg1) /* wrapper */

#define MUX_ADDR_(arg1, arg2, arg3, arg4, argb) arg1/* get 1st value from macro 7/
#define PAD_ADDR(arg1) PAD_ADDR_(arg1) /* wrapper */

#define PAD_ADDR (arg1, arg2, arg3, arg4, args) argb /* get 5th value from macro */
fs_dlio_test_imx_t dio_safety_test_item_0 =

{

.gpio = GPIO1_BASE,

.pinNum = 15U,

.oinDir = PIN_DIRECTION_IN,

.muxAdadr = MUX_ADDR(IOMUXC_GPIO_AD_B0_15_GPIO1_1015),

.padAddr = PAD_ADDR(IOMUXC_GPIO_AD_B0O_15_GPIO1_/015), };

/*NULL terminated array of pointers fo dio_test t items for safety DIO test °/
fs_dio_test_imx_t *dio_safety_test_items[] = { &dio_safety _test item_0, &dio_safety test item_1, NULL };
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Example application
4.4 Source file - safety_safety_cm4_cm7_<platform>.c/.h

The safety cm4_cm7 _imx8m.csafety cm4_cm7 _imxrt.c source file and the corresponding */ file contain a library handling
function. Each function contains a detection. If a safety error ocurrs, the SafetyErrorHandling() function is called.
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Chapter 5
Running example

For the first run of the example on your hardware, it is recomended to turn off Flash, WDOG, Clock, AlO, and DIO test. In the next
step, turn on step by step.

When the WDOG is turned off and a safety error happens, the example stays in an endless loop.

5.1 FreeMASTER monitoring

FreeMASTER is used as the external PC tool for real-time monitoring. FreeMASTER is also implemented in the IEC60730B safety
examples. For simplicity reasons, the MAP file is the source of the variable address. Before connecting FreeMASTER to your
application, make sure that the application is running.

Running FreeMASTER:

Download and install FreeMASTER from www.nxp.com/freemaster.
The example project is in the safety.pmp file. Open it.
Check the project settings for your application:
* Open "Project->Options ->MAP Files". It must point to your output files.

IAR IDE and ARM Keil IDE

Navigate to the boards/<your board>/demo_apps/safety iec60730b/<compiler>/<debug or release>/".outfile.

MCUXpresso IDE

Navigate to the <workspace>/<project name>/<Debug or Release>/<project_name>.axffile.

Options >

Comm MAP Fies ] Pack Dir] HTML Pages ] Demo Mode ] Views & Bars ]

Default symbol file: | Waridebug'safety_iec60730b out
File format: |Ell'|aﬁ' ELF with DWARF2/DWARF4 dbg format. J Edit
List of all valid

symbal files:

Note: The file selected in the list will be used as default symbol file
when the project is opened

Behawior
[
[+ List symbol emors (varables using undefined symbols)
* Mways { Except afterinitial project load

OK | Cancel

Figure 9. Example of setting MAP files for FRDM-KV11 board

* Open "Project ->Options ->Comm" and select a correct RS-232 connection and speed. The connection speed is in the
safety_config.hfile's "SERIAL_BAUD_RATE" macros. By default, this speed is set to 9600 bd.
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Running example

Options

Comm | MAP Files | Pack Diri HTML Pages | Demo Mode | Views & Bars]

X

—Communication

@ RS232 Pot |COM_ALL v | |All COM prts will be scanned

Speed: IQGD[] vl Timeouts... I

" Plug-in module: |

=

Connect string | vl _onfigure |

[~ Save settings to projectfile [v Save settings to registry. use it as default

Communication state on startup and on project load
("~ Open port at startup
(@ Do notopen port at startup
{— Store port state on exit, apply it on startup

[ Store state to project file. apply upon its load Advanced...

OK Cancel

AL |

Figure 10. Setting UART speed

Now you can connect to the development board by pressing "CTRL+G" or clicking the "GQO" button:
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Running example

'@
- File Edit View Explorer Project Tools Help

=W

) f & K72 i Tahoma

| @ Start communication (Ctrl+G) M

|

= Open port and and start - - S
#= Dema communication MName Value
44 Demo necoruer

—+—-5atetyComman.CPU_control_test_result 0x0

q_sSafetyCommon.CPU_non_stacked_test_result 0x0
q_sSafetyCommon.CPU_primask_test_result 00
! q_sSafetyCommon.CPU_req_test_result 0x0
| | q_sSafetyClockTest.clockTestContext 102
| q_sSafetyClockTest.clockTestExpected 102

q_sFlashConfig.checksum16 Oxe25h

q_sSafetyCommon.FLASH_test_result Oxe25b
| g_sSafetyCommon.CLOCK_test_result 0x%0
| | g_sSafetyCommon.DIO_input_test_result 0x0
| g_sSafetyCommon.DIO_output_test_result 0x0
| g_sSafetyCommon.DIO_short_test_result 0x0

| | g_sSafetyCommon.AIO_test_result 0x704

| g_sSafetyCommon.PC_test_result 00
| g_sSafetyCommon.RAM_test_result 0x0
q_sSafetyCommon.STACK_test_result Ox0

| 0_sSafetyWdTest.watchdogResets 1]
q_sSafetyCommon.safetyErrors 0x0

': E‘Application Co.. !E\far\able Stimulus

Open port and and start communication Not connected

Figure 11. Safety example FMSTR application
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Usually, the AIO test is a number of results oscillating between 0x0 and 0x704 (test passed and test in progress).
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Chapter 6
IEC60730B tests

The library contains the following tests:
* Analog I/O test
* Clock test
* CPU register test
+ Digital I/0 test
* Invariable memory (flash) test
» Variable memory (RAM) test
* Program counter test
+ Stack test
» Watchdog test
» Touch-sensing peripheral TSIv5 test

The following chapters describe each test with focus on the example application (debugging).

6.1 AIO test

The analog IO test procedure performs the plausibility check of the digital 10 interface of the processor. The analog 10 test can
be performed once after the MCU reset and also during runtime.

There are three values tested in the application:
* VrefH
» VrefL
» Bandgap

Ensure that the ADC peripheral is set up correctly before calling the AlO test. In some cases, it is necessary to connect this signal
externally (by a wire) to the corresponding pin. The test is perfomed in a sequence, as defined in the safety config.hfile:

/*ADC test /

{1

{(uint32_ADC_MIN_LIMIT(0), (uint32_)ADC_MAX_LIMIT(60)}, |
{(uint32_ADC_MIN_LIMITAADC_MAX), (uint32_t)ADC_MAX_LIMIT(ADC_MAX)},|
{(uint32_)ADC_MIN_LIMITAADC_BANDGAP_LEVEL_RAW),
(uint32_)ADC_MAX_LIMIT(ADC_BANDGAP_LEVEL_RAW)} }

#define FS_CFG_AIO_CHANNELS_INIT {6, 5, 4} /* ADC Channels for V_refi, V/_refh, bandgap */

An example of the setting is shown above. The "FS_CFG_AlIO_CHANNELS_/NIT"macro defines that the ADC channel 6 is tested
first, with the limits corresponding to VrefL (GND). Channel 5 is tested next, with the limits of VrefH (VCC). Channel 4 is tested
next, with the limits for the bandgap.
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IEC60730B tests

6.2 Clock test

The clock test procedure tests the oscilator frequency for the CPU core in the wrong frequency condition.

NOTE
The default clock setting from the SDK library is used in the example. For a real application, ensure that the
reference clock source is not dependent on the primary (tested) clock.

6.3 CPU register

The CPU register test procedure tests all CPU registers for the stuck-at condition (except for the program counter register). The
program counter test is implemented as a stand-alone safety routine.

Some tests stay in an endless loop in case of an error, others return a corresponding error message.

6.4 DIO test
The Digital Input/Output (DIO) test procedure performs the plausibility check of the processor's digital 10 interface.

NOTE
Make sure that the time between the "set" and "get" functions is sufficient for the GPIO peripheral speed.

6.5 Invariable memory test

The invariable (Flash) memory test provides a CRC check of a dedicated part of memory. This test is turned off by default in the
safety_config.hfile.

The test consists of the following two parts:

» Post-build CRC calculation of the dedicated memory.

* Runtime CRC calculation and comparison with the post-build result.
The post-build calculation is different for each IDE:

In the IAR IDE, the CRC is calculated by the IDE directly using the linker (see Options->Build Action). The Flash test is fully
integrated to the example project in the IAR IDE. It is necessary only to turn this test on in the safety_config.h file.

In the Arm Keil IDE, it is necessary to use a third-party tool (Srecord):
» Srecord and all necessary settings are added to the presented example by default.
» Turn on the Flash test in the safety_config.hfile.
» The final post-processed image is downloaded to the ROM memory using the "Download" button.

» For more information on using Srecord in Arm Keil IDE, see Calculating Post-Build CRC in Arm”® Keil’ (document
AN12520).

In case of an issue, check the following settings:

» Check if the "Option -> User -> AfterBuild" tab contains the ".I..l..I..l..Imiddlewarelsafety iec60730blfools|crcicrc_hex.bat
-.l.l..I..1boards/<YOUR_BOARD>|demo_appsisafety_iec60730blmdkidebuglsafety_iec60730b.hex
-.l.l..L..1boards|<YOUR_BOARDI\demo_appslsafety_iec60730blmdkldebug|safety_iec60730b_crc.hex
-..l.l..I..lfools|srecord|srec_cat"path and if the checkbox is selected (it should be filled and checked by default).

» Check if the "Option->Debug ->Initialization File" tab contains the "./././.././middleware/safety iec60730b/boards/
common/debug.inl' path.

In the MCUXpresso IDE:
» Srecord and all necessary settings are added to the presented example by default.

* Turn on the Flash test in the safety_config.hfile.
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» Create the "debug configuration" for your debbuger.

IEC60730B tests

» Open the "Debug Configurations" menu ("Run->Debug configuration") and select the "Startup” tab. In this tab, select
"Load Image -> Use File -> <YOUR_BOARD>_safety (ec60730b_crc.hex".

» This edited HEX file is located in the <workspace>/<your_project>/Debug/<your._project>_crc.hex folder.

. Debug Configurations

Create, manage, and run configurations

FaEX BT

I \
C/C++ [NXP Semiconductors) MCU Applicat
[E] C/C++ Application
[E] C/C++ Attach to Application
[E] C/C++ Postmortem Debugger
[E] C/C++ Remote Application
[£] GDB Hardware Debugging
m GDB PEMicro Interface Debugging

~ GDB SEGGER Interface Debugging
ﬂ frdmk22f_dev_safety iec60730b JLink Deb:
¥ Java Applet
[T] Java Application
R Launch Group
= Launch Group (Deprecated)
T Remote Java Application
> XSL

< >
Filter matched 13 of 13 items

@

[£] Main | %5 GDB Debugger | % JLink Debugger | & GUI Flash Tool | Other Symbols | = Startup

Mame: | frdmk22f_dev_safety_iec60730b ILink Debug

E_, Source| [] Common
Initialization Commands

[JReset and Delay (seconds): 3

[IHalt

monitor reset

Load Image and Symbols
Load image

OiUse project binary:  frdmk22f_dev_safety_iec60730b.axf

(@) Use file: ‘ S{workspace_loc\frdmk22f_dev_safety iec60730b\Debug\frdmk22f_dev_safety iec60730b_crc.hex} | Workspace... File System...

Load symbols

@ Use project binary:  frdmk22f_dev_safety_iec60730b.axf

(O Use file: Workspace... File System...

Symbols offset (hex): l:l

Run Commands

[ P T hd
Revert Apply

Figure 12. Using output HEX file with calculated CRC in MCUXpresso IDE

In case of an issue, check also the following settings:

» Check if the post-build actions are set: "arm-none-eabi-objcopy -v -O ihex "$
{BuildArtifactFileName}" "${BuildArtifactFileBaseNamej}.hex" ${ProjDirPath}/linker/crc_hex.bat -..111${ConfigName}
1frdmk22f_dev_safety _iec60730b.hex -..111I${ConfigName}Ifrdmk22f dev_safety iec60730b_crc.hex -..|Isafety _iec60730b]
ltoolsllsrecllsrec_cat". It should be filled by default.

NOTE

When you debug your application with the Flash test turned on, be careful when using the breakpoint. The software
breakpoint usually changes the CRC result and causes a safety error.

6.6 Variable memory test

The variable memory on the supported MCU is an on-chip RAM.

The RAM memory test is provided by the MarchC or MarchX tests.

The test copies a block of memory to the backup area defined by the linker. Be sure that the BLOCK_SIZE parameter is smaller
than the backup area defined by the linker.

NOTE
This test cannot be interupted.
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6.7 Program counter test
The CPU program counter register test procedure tests the CPU program counter register for the stuck-at condition. The program
counter register test can be performed once after the MCU reset and also during runtime.

NOTE
The program counter test cannot be interrupted.

6.8 Stack test

This test routine is used to test the overflow and underflow conditions of the application stack. The testing of the stuck-at faults in
the memory area occupied by the stack is covered by the variable memory test. The overflow or underflow of the stack can occur
if the stack is incorrectly controlled or by defining the "too-low" stack area for the given application.

NOTE
Choose a correct pattern to fill the tested area. This pattern must be unique to the application.

6.9 Watchdog test

The watchdog test provides the testing of the watchdog timer functionality. The test is run only once after the reset. The test causes
the WDOG reset and compares the preset time for the WDOG reset to the real time.

For this test to run correctly, it is necessary to keep the WDOG_backup variable in a part of memory which is not corrupeted by
the WDOG reset.

NOTE
Some debuggers do not allow the WDOG reset. Due to this, it is necessary to turn off the WDOG when debugging
the application.
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